
Using Crystal Reports with Lucity 

Advanced - 3 

The seventh of a seven-part series, this workbook is designed for Crystal Reports® users creating Work 

reports.  This guide goes over particular steps and challenges in creating reports for work orders. Most 

of the following items can be issues found in creating other reports, however; they are very common in 

Work reports.  Some of the general issues have been discussed previously so are included again for 

review. 
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Adding Tables 
Bring in all of the tables that could possibly be filtered on in the report. 

The following is a simple Work Order Report with fields from the WKORDER table with only the 
WKORDER table in the Database Expert. 

 

 

 

o If this report is run in Lucity with a filter on Resource Code equal to 1 (employee) then the 

following error will show up and the report will not run.   

 

  

• The error occurs because the WKRESRCE table is not a part of this report. 

o Bring in any tables with possible fields to be filtered on into the Database Expert and Link. 
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The standard Work Order Summary report has the following tables yet only shows fields from the 

WKORDER and WKORDERLOC tables: 

  

 

➢ In general, the tables are linked with “Left Outer Join” connections.  If the table on the left is 

true then move to the right for the next information.  This shows with an arrow pointing to the 

“Connecting” tables.   

➢ Inner joins can be used – information in both tables has to exist – but sometimes Crystal has 

some issues with this linking.  This shows with a line with no arrows.   

➢ Some older reports show all of the connections without arrows even though they are “Left 

Outer Joins”.  If looking at an old standard report and all of the connections look like inner 

joins, check each connection by double clicking each line and finding the Join Type 

description.  

Many items in the Work Order module are found in grids.  Each grid uses a different table. 

➢ The normal user wants to start grabbing tables, linking and pulling in fields.  As long as you can 

find the correct linking fields this should work, right? Wrong.  There may be issues with 

multiple lines showing and possible problems with running the report with a filter. 

 

A typical field an end user might like to see is the Address.  It will be necessary to bring in the 

WKORDERLOC table to be among the tables in the main body of the report so the report can be run 

with an address filter.  If the address is brought directly in from this table, the following occurs: 

 

 

• The Work Order # 2006-01128 shows up twice because in this record there are two 

addresses in the Address grid.  This might not be a problem to see the work order for 

each location but the Total Cost is going to show up each time as well, which is 

normally undesirable.   
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Possible ways to handle this: 

1. If you want just one of the addresses, you could group on WO_NUMBER and then place all of 

the fields in the Group Header or Footer section.   

 

 

 

o Depending on whether you wish to see the top address or bottom address in the Work Order 

Location grid, you could go into the Record Sort Expert and select the address field to sort on 

in either ascending or descending order. 

 

 

 

2. Another possibility is grouping on WO_NUMBER and then putting the address formula in the 

Detail section. This would allow all of the addresses in the Location grid to show.  
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• There can still be problems if another field from another grid is brought in.  In this next 

example the subtask from the WKWOTSK table is used. 

  

 

• There are three subtasks for this work order and one of the Tasks has two resources.   

So, for each address each task/resource combination is brought in.  You definitely 

don’t want this to happen.  The problem is the way Lucity passes the information over 

to Crystal Reports.  

 

The best way to handle grid information is with subreports.  Both the SubTask and Address 

fields can be put in subreports. 

 

 

 

 

 

 

 

 

Note:___________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________ 

_______________________________________________________________________________

_______________________________________________________________________________ 
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Adding a Comments Section 
The data from the Comment tab within Work Orders and Requests is brought into the report 

differently than the Comment sections in other modules.  For this example, we’ll add a Comment 

subreport to the Work Order Summary Report. 

1. First, we’ll find the field definition for the Work Order Comment section. 

a. Open the Work Orders Standard module.  Click on the Comments tab. 

  

b. Right click in the grid.   

c. Select Add Comment or View Details for an existing comment.   

d. Ctrl + right click in the large comments box to view the field definition.  Note that the 
table name is WKGDMEMO and the field name is GM_MEMO.   

e. Close the comment dialog. 

Note:  This Comment section does not hit the WKMEMO table.  Instead, it uses the 
WKGDMEMO table. 

 

2. Open the Work Orders module’s Report Dialog.   

3. Export the WOSum.rpt report and rename it LC_WOSumComment.rpt.  Open the renamed 
report.  

4. Right click in the left margin of the Group Footer 1a section and select Insert Section Below. 

5. Click Insert Subreport .  

a. In the New report name section, type a name for the subreport (Comment).   

b. Click Report Wizard.   

6. Open Create New Connection>>ODBC>>GBAWork001 (Finish)>>Tables.   

a. Move the WKGDMEMO table to Selected Tables.   

b. Then, choose Finish and OK.   

7. Insert the Comment “box” into the Group Footer 1b section. 

8. Choose subreport formatting options and resize the box. 

9. Right click within the Comment box and select Change Subreport Links. 
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a. Select fields so it looks like the following:  

 

 
b. Click OK. 

10. Double click on the Comment box. You are now in the Comment subreport.  

11. Click Select Expert and add the following to the formula: 

and {WKGDMEMO.GM_PARENT} = "WKORDER" 

o This can be done with the New tab. 

OR 

a. In the Formula Editor > Formula Workshop you can type “and” 

b. Double click the field, WKGDMEMO.GM_PARENT 

c. Type in “=” 

d. Right click on WKGDMEMO.GM_PARENT within the list of fields and click Browse Data 

and select WKORDER, Paste Data. 

e. Select Save and Close and then click OK. 

 

Note:  The formula in Requests would look like this: 

{WKGDMEMO.GM_PAR_ID} = {?Pm-WKREQ.RQ_ID} and  

{WKGDMEMO.GM_PARENT} = "WKREQ" 

 

12. Add column titles.  You’ll want to make the titles bold and underlined in order to make them 

distinct. 
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13. Drag in the appropriate fields.  

o You’ll need to create formulas for the Date and Time fields before adding them. 

14. Increase the size of the GM_MEMO field and format it so it Can Grow. 

15. Place a box around the Comment subreport to separate it from the rest of the data.  Make sure 

the bottom of the box is in the Report Footer section so the box will grow to accommodate the 

Memo field if necessary.  

a. Add a title for the box (Comments).  

b. Format the Comments text box with a white background. 

 

 

16. Click the Design tab.   

17. Click the Section Expert button.   

a. Select Group Footer1b and the Suppress Blank Section option.   

b. Select Group Footer 1 and the Keep Together option.   

c. Then, click OK. 

 

Preview 

 
 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 
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Linking 
When a subreport is added to a report, the linking procedure is usually straight forward; however, 

there are exceptions throughout the Lucity modules.  We previously discussed one such exception: the 

XXMEMO table to the Main table for Comments.  Here, the linking field was not obvious.   

There are other situations where information in a grid requires a go-between table to work with the 

parent module.  When creating a report, this go-between table is required to connect the subreport to 

the main report.  For example, when Work Orders or Requests are linked to Work Orders or Requests, a 

go-between table called WKWOMWO is needed.   

This is a special linking table and is NOT a simple many to many relate table. It is a many to self, many 

to many table. 

You CANNOT do the following linking: 

WKORDER.WO_ID to WKWOMWO.MW_WO_ID 
WKWOMWO.MW_RQ_ID to WKREQ.RQ_ID 

Linking Work Orders to Requests 
In our first step-by-step example, we will link a Work Order subreport to a Request report. 

1. We will modify the Summary of Requests (ReqSum.rpt) report from the Request module.  From 

the Work report folder open LC_ReqSumLinks.rpt. 

2. Open the Database Expert. 

3. Add the WKWOMWO table and link it to WKREQ. 

 The connected fields usually have an ID field with a common part; in this case, it is RQ.  

a. To link the tables, click on the joining field in the “parent” table and drag it onto the 

joining field in the connecting table. 

b. Double click on the joining arrow and select the Left Outer Join Link Option.   

c. Click OK and then click OK again. 
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4. Add a Detail section for the Work Orders subreport. 

5. Create a subreport (Linked Work Orders).   

a. For the Selected Tables, bring in WKORDER and WKWOMWO.  

b. Select Next and link the tables.  Left Outer Join.   

• The “parent” table will be the table that is linked to the main report. (Usually 
placed far left, top) 

c. Click Finish and then click OK. 

  

  

 

6. Place the subreport in the new Details section. 

7. Select the formatting options and resize the subreport.   
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8. Right click in the Linked Work Orders subreport box and select Change Subreport Links.  Set 

up as shown below: 

 

9. Open the Linked Work Orders subreport. 

a. Set up the subreport with the desired information.   

 

 

b. Open the Section Expert in the main report and select Suppress Blank Section for the 

subreport Detail section. 

10. Preview the report. 
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11. In our example, there is an extra space above the first Work Order record.  One way to remove 

this space is to go back into the Linked Work Orders subreport Select Expert and add a 

statement for Work Order IDs greater than zero. 

 {WKWOMWO.MW_MW_ID} = {?Pm-WKWOMWO.MW_MW_ID}  

 and {WKORDER.WO_ID} > 0 

o As you can see in the Preview screen below, this additional statement has removed the 

blank space from above the first Work Order record. 

  

 

o Another way to handle the blank line is to use the Section Expert in the subreport.  

Select Suppress blank section for the Detail section. 

Linking Requests to Requests 
For our next example, we’ll continue with LC_ReqSumLinks.rpt from above.  Here, we’ll add the 

linked Requests. 

1. Add a Detail section beneath the Linked Work Orders subreport.  

2. Insert a subreport named Linked Requests. 

a. For the Selected Tables bring in WKWOMWO and WKREQ.  

 

b. Link as follows: 
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c. Place the subreport in the newly created Detail section. 

d. Select formatting options, and resize. 

3. Right click on the Linked Requests subreport and select Change Subreport Links.  Set up as 

shown below:  

 

o You do not want to show the request you are in when listing linked requests, so an 

additional linking statement needs to be added. 

 

 

4. Open the Linked Requests subreport and click Select Expert. 
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5. You’ll need to modify one of the linking formulas created in Subreport Links. 

 
 {WKWOMWO.MW_MW_ID} = {?Pm-WKREQ.RQ_MW_ID} and 

 {WKREQ.RQ_ID} = {?Pm-WKREQ.RQ_ID} 

 
o Change the second formula to “not equal”. 

o You can do this in the Formula Workshop by highlighting the “=” and then opening 

Operators>>Comparisons and double clicking Not Equal (x<>y).  OR You can just type in 

“<>”.  The “=” will be replaced with “<>”.   

o Remember to Save and Close the Formula Workshop and select OK to close the Select 

Expert.  The new formula will appear as follows: 

 
 {WKWOMWO.MW_MW_ID} = {?Pm-WKREQ.RQ_MW_ID} and 

 {WKREQ.RQ_ID}  <> {?Pm-WKREQ.RQ_ID} 

 
6. Set up the subreport with the desired information.   

7. Go back to the main report and open Section Expert.  Select Suppress Blank Section for this 

new Detail section. 

 

Preview 

 

Linking Requests to Work Orders 
The procedure for adding the linked subreports is very similar to the above examples. 

In this case, we’ll add a Linked Requests subreport to the Work Order Summary Report. 

1. We will modify the Work Order Summary (WOSum.rpt) report from the Work Order module.  

From the Work report folder open LC_WOSumLinks.rpt. 

2. Open Database Expert and add the WKWOMWO table, linking it to WKORDER.  

 



Crystal Reports for Work Orders 15 

 

 

3. Add an additional Group footer section beneath GF1a.  This will be the new GF1b. 

4. Create a subreport named Linked Requests with the WKWOMWO and WKREQ tables. 
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5. Insert the Linked Requests subreport into the new GF1b section. 

6. Right click on the subreport and select Change Subreport Links. 

 

7. Proceed with the subreport details as previously demonstrated. 

Linking Work Orders to Work Orders 
We will continue with the open LC_WOSumLinks.rpt report and add a second subreport, Linked Work 

Orders. 

1. Add a new Group Footer section. 

2. Create a new subreport named Linked Work Orders and bring in the WKWOMWO and 

WKORDER tables. 

 

3. Place the Linked Work Orders subreport in the new Group Footer section. 
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4. Right click on the subreport and select Change Subreport Links. 

 

AND 

 

5. Open the Linked Work Orders subreport and click Select Expert. 

6. Change the formula as discussed previously. 

 

{WKWOMWO.MW_MW_ID} = {?Pm-WKORDER.WO_MW_ID} and 

{WKORDER.WO_ID}  <>  {?Pm-WKORDER.WO_ID} 

 

7. Proceed with the subreport details. 

                                                                                                                    Example 30A 
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Work Order Reports with Assets  

Asset Inventory Numbers 
You can use the Asset number for record selection.  By adding a formula in the Select Expert section, 

you can limit records to the desired assets.   

The following Asset values are required to create any formulas that would select specific Assets. This is 

not a complete list. 

 

 

 

Note: These Assets come from the WKCATINV table.   
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Limiting Record Selection to Specific Assets 
We will create a Work Order Summary Report that will show only Sewer Pipe and Manhole work 

orders with their assets. 

1. From the Work report folder open LC_WOSumPipeMan.rpt. 

2. You can view just Sewer Pipe and Manhole records by adding the following formula to the 

Select Expert: 

a. Open Select Expert. 

b. Click on WO_INV_ID. 

 

 
c. Click OK. 

d. Set up as follows. 

 

 
e. Click OK. 

Note: The 6 (Sewer Pipe) and 2 (Sewer Structure) values come from the WKCATINV table on 

the previous page. 

 



Crystal Reports for Work Orders 20 

OR 

a. You can click Report>>Selection formulas>>Record. 

b. Type in the following formula: 

{WKORDER.WO_INV_ID} in [2, 6] 

 

Preview 

 

As you can see in the above example, the new Work Order Summary Report displays only the Sewer 

Pipe and Manhole records. 

Asset Subreports 
We will now add Asset subreports to the limited Work Order Summary Report we created above. 

1. We are going to “borrow” subreports from WOFormSewerAsset.rpt. 

a. Click File in the top tool bar, then Open, and then double click  

WOFormSewerAsset.rpt. 

b. Right click on the SWPipe.rpt subreport. 

c. Select Save Subreport As. 

d. Enter a name for your subreport (SWPipeSub.rpt) and then Save the subreport.  Make 

sure it is saved in the Work report folder. 

e. Repeat these steps for the SWStruc.rpt subreport, giving it a new name as well.  

▪ For example, we’ve named this subreport, SWStrucSub.rpt. 

Note: When you are finished with these subreports, you may want to delete them from your 

“family” of Work reports.  This will help avoid confusion in the future. 

 

2. Close WOFormSewerAsset.rpt. 

3. You are back in LC_WOSumPipeMan.rpt.  Insert two new Group Footer sections. 

4. In your new Group Footer sections, insert the two subreports using the Choose an existing 

report option. 

5. Choose the subreport formatting options.  Remember to suppress the blank subreports within 

formatting and in the Section Expert. 
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6. Link the subreports. 

 

 

7. Within the subreports, remove the blank sections. 

8. Remove the “old” linking formula in each subreport’s Select Expert. 

 

 

 

Preview 

 

 

                                                                                                                                                  Example 31A 
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Bringing in Asset Work Orders  
In a Work Order report with Assets, it is sometimes desirable to see all of the Work Orders associated 

with the Assets.  This is helpful in determining if the asset is being plagued with problems. 

1. From the Work report folder open LC_WOSumPipeManWOs.rpt.  We will set up the Pipe asset 

subreport (SWPipeSub.rpt) to bring in any associated work orders. 

 The original tables for this subreport are linked as follows: 
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2. Additional tables are needed.  Bring in WKORDER and an additional WKWOASSET which will 

show as WKWOASSET_1.  Left outer joins. 

 

 

3. Grouping should be added for the AS_LINK1 field.  The fields in the Detail section will be 

moved into the Group Header section. 

4. Bring in the WO_NUMBER field and the WO_ACTN_TY field into the Detail section. 

5. Create a formula (WOTitle) that will show when there are any other work orders associated 

with this asset: 

 If {?Pm-WKORDER.WO_ID} <> {WKORDER.WO_ID} then "Additional Work Orders" 

6. Group on this formula so that it will show only once for a list of work orders. 

7. In the subreport Section Expert click on the Group Header #2 section and select Suppress Blank 

Section. 

8. In the subreport Section Expert add a conditional suppression formula for the Details section.   

  {?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID} 

 This will suppress the work order number the asset is associated with in the main report.  
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The Pipe subreport now looks like this: 

 

 

Preview 
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Bringing in Comments for the Asset Work Orders 
To view the comments that are associated with each Asset work order we will continue with 

LC_WOSumPipeManWOs.rpt. 

1. The Work Order Comment is shown by bringing in the WKGDMEMO table then linking to the 

WKORDER table.  Left outer join. 

 

 

 

2. Create a new group on the WO_NUMBER field. 

3. Move the data in the Detail section into the new Group Header section (GH3). 

4. Add the GM_MEMO field to the Detail section.  

5. In the subreport Section Expert for Group Header #3, add the following formula to Suppress. 

 {?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID} 

 Also select Suppress Blank Section. 
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6. In the subreport Section Expert for Details: 

a. Add the following formula to Suppress. 

 ({?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID}) 

 Or ({WKGDMEMO.GM_PARENT} <> "WKORDER") 

b. Also select Suppress Blank Section. 

 

 

Preview 
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Filter on Grid Fields and the Impact on Reports 
If you have a module that allows you to filter on a field that is in a grid with multiple records and you 

plan on running a report (without groupings) with this field as a filter, then the report may have some 

issues.  If you have a field you wish to summarize, you need to set it up with groupings and variables or 

running totals.   

For example, in a Work Order report where the fields have been placed in the Detail section without 

Grouping - the following could occur: 

Filter on a grid field that has multiple values and run the report against this filter and see what the 

numbers do.  Resource = 1 (employee) is a good one. 

The filter can be found when you click Advanced. 

 

Then click on the “Report SQL” tab.   

Lucity passes to Crystal the following statement. 

{WKRESRCE.WR_RTYP_CD} = 1 

When the report runs, it looks at the record every time the statement is true.  If a report had three 

employees then it would hit the record three times. 

In WO# 2006-01128 there are two employees so when the report is run with a resource filter the work 

order line shows up twice. 
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If the information being summarized is in the WKORDER table, then grouping on the WO_NUMBER and 

setting up variables should be sufficient.  If you are summarizing a field within Task or Resources you 

will need to further group.  In most cases using a Running Total is equally effective as the variables. 

Using Variables in a Report 
The original Work Order Category Summary (WOCatSum.rpt) report looked like this: 

 

 

It was a very simple report which grouped on Category and used the Crystal Summary tool to calculate 

the Group Total and Grand Total.  This worked when the report was run without filters.   

 

There were certain filters that caused duplicate Work Order costs.  The problem filters are the fields 

that come from grid data.  In the Work Order module these would include Location, Assets, Tasks and 

Resources.  This occurs because of the filter statement being passed from Lucity to Crystal.  If there 

are two Tasks on a Work Order that are true for a Task filter being run then the report will run the 

record twice.   

When the report was run with a resource filter on Work Orders that have employees these same 

categories looked like this: 

 

There is an obvious difference in the cost fields.  Instead of possibly going down due to records being 

filtered out that had no employees, the cost actually went up. Some work orders had multiple 

employees so the cost  was summed each time the filter was true.  The count was calculated using the 

Distinct Count option as opposed to the Count option for calculating so there was no duplication of 

records. 
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To correct this issue we used grouping and variables.   

 

 

Open WOCatSum.rpt and follow the steps used to correct the report. 

 

 

1. Add a second grouping on the Work Order Number, WO_NUMBER. 

2. Create a formula for the Work Order Cost (WOCost) and place it in the WO Number Group 

Footer 2. 

WhilePrintingRecords; 

Shared numberVar WOCost ; 

WOCost:={WKORDER.WO_TOTCOST} 

3. Create a formula to summarize the cost for the Category (CatWOSum). Add a new section 

below the WO Number Group Footer 2.  This is a second Group Footer (GF2b) for this section.  

Place this new formula in this section. 

WhilePrintingRecords; 

Shared numberVar CatTot ; 

Shared numberVar WOCost ; 

CatTot:= CatTot + WOCost 

4. Create a formula to summarize the total cost for all Work Orders (TotSum).  Place this in GF2b. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

Shared numberVar WOCost ; 

TotWOCost:= TotWOCost + WOCost 
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5. Create a formula to reset or zero the Work Order cost variable (ZeroWO).  Place this in the WO 

Number Group Header #2 section. 

WhilePrintingRecords; 

Shared numberVar WOCost:=0; 

6. Create a formula to reset the Category Cost variables (ZeroCat).  Place this in the Category 

Group Header #1. 

                   WhilePrintingRecords; 

       Shared numberVar CatTot:=0; 

7. Create a formula to show the Category total cost (CategoryTot).  Place this in the Category 

Group Footer #1. 

                  WhilePrintingRecords; 

                  Shared numberVar CatTot ; 

                  CatTot 

8. Create a formula to show the Grand Total Cost (Total).  Place this in the Report Footer. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

TotWOCost 

9. Suppress the new Group Header and Footer sections. 

It depends on the report as to whether you use variables or running totals to solve filter issues.  At the 

time the report was revised the use of variables was the choice method to correct the issue. 

Variables are also very useful to pass information from a subreport to the main report.   

Sometimes with complex reports variables are necessary to calculate the data correctly. 
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Using Running Totals in a Report 
The same report could have been modified using Running Totals to correct the filtering issue.   

1. The additional grouping on the Work Order number is still necessary. 

2. Two Running Totals are created.   

o One for the Category cost (CatCost). 

• The Evaluate is set up as “On change of group” and the group is “Group #2”, 

the Work Order Number. 

• The Reset is set up as “On change of group” and the group is “Group #1”, 

Category. 
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o The second running total is to calculate the cost grand total (TotCost). 

 

• It Evaluates on the same group as the Category cost running total but the Reset 

is Never. 
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Secured Fields  

Secured Fields in the Main Body of Report  
Sometimes, fields should be hidden in reports if the person viewing the report does not have the proper 

level of security.  This can be done by using parameters and formatting options.  

Note:  This will only work for fields in the main body of the report.  Fields that need to be 

hidden in subreports will be addressed next. 

 

Many cost fields in Work Order reports are set to use the “Hidden” option.  Sometimes you may wish to 

suppress the fields completely. 

The following steps are provided to set up the field security. 

1. Right click Parameter Fields and select New.   

2. Type in the Name - ViewSecuredFields.   

▪ This is a special parameter field that must have this name “ViewSecuredFields”.          

When the report is run within Lucity, the security is passed to the report and will 

not query the user.  If the report is run outside of a Lucity module, in Crystal, then 

the security will be queried. 

▪ If the report is refreshed, it will ask for the parameters again, including the 

permission to view the secure fields.  At this point you can change the security 

value the report will run with. 

3. Select the Type > Number and under Options > Discreet Value -True.  

4. Click OK.   

Field Viewing Options 

 Field to Show Blank 

 For a blank field to show up when the user does not have rights to view the secured fields, do 

 the following:  

1. Right click the field that requires suppression and select Format Field.   

2. Click the Common tab.   

3. Click the formula box  next to Suppress.  

4. Double click the ViewSecuredFields parameter from the Report Fields.   

5. Type “= 0”. 

{?ViewSecuredFields} = 0 

6. Click Save and close. 

7. Click OK 
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  Field to show “Hidden”  

For the word “Hidden” to show up when the user does not have rights to view the secured 

fields, do the following:  

1. Right click in the field that requires suppression and select Format Field. 

2. Click the Common  tab 

3. Click the formula box  next to Display String. 

4. Type in: 

if {?ViewSecuredFields}=0 then "Hidden" else "$"& totext(the field that is to show) 

Note: The inclusion of the dollar sign is because once the formula brings in the word 

“Hidden”, the formula requires the outcome to be text.  The field will not allow number 

formatting.  That is also the reason for the conversion of the field to text. 

5. Click Save and Close. 

6. Click OK 

It would be helpful to make a notation at the bottom of the report to explain why some of the fields 

are “Hidden”, such as: 

“A Hidden field indicates permission to view the secured field is turned off.” 

Secured Fields in Subreports 
The ViewSecuredFields parameter is sent to the report from the Lucity software security setup.  This 

parameter value only reaches the main body of the report.  In order for a subreport to use this value it 

needs to be passed into the subreport as a variable.  

 

We will look at the Work Order Detail Report (WODetail.rpt) and see how security was added to the 

cost fields in the Task/Resource subreport. 

1. First, we used a shared variable called Security.  It was declared in both the report and 

subreport. 

o Open WODetail.rpt.  The ViewSecuredFields parameter was created.   

o A new formula was created called Security to declare the variable. 

 Shared NumberVar Security:= {?ViewSecuredFields}; 

2. The new Security formula was placed into the Report Header section.  The field size was 

reduced and the field text formatted to have white font.  This ensured that the formula was 

not visible in the report. 

3. In the TaskRes.rpt subreport a new formula called SecuritySub was created.   

             Once again, the Security variable was declared. 

   Shared NumberVar Security; 

o The formula was dragged into the suppressed Report Header. 
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4. There are four fields set up to show “Hidden” if the user does not have proper security.  These 

are designated with asterisks (Cal’c UC, Task Costs, Unit Cost and Total Cost).  

Variables – Passing information from a 

subreport to the main report 
Let’s create a report that shows the number of Requests and Work Orders for each Request Problem 

type.  The number of Requests is straightforward enough with the use of a Running Total field.  The 

number of Work Orders gets a little trickier because Work Orders are attached to Requests through a 

grid and thus need to be brought into the report as a subreport.  Information from a subreport to a 

parent report can be done by using variables. 

1. Create a new Work Report from the Crystal Report Blank Report option and name it 

LC_ReqSumRQWO. 

2. Bring in the WKREQ table.  Bring in the Problem field (RQ_PROB_TY) and the Request 

Number (RQ_NUMBER): 

3. Group by Problem Type.   

4. Move the Problem field to the Group Footer. 

5. Add a Number of Requests column title.  

6. Add a Problem column title.  

7. Create a Distinct Count of the Request Numbers for each Problem Type and place it under the 

column header in the Group Footer section. 

8. Add a “Total” text in the Report Footer section.  Then put in a Distinct Count of the Request 

Numbers into the Report Footer. 

9. Add a Report Title “Summary of Requests and Work Orders”. 

 

 

10. Add the WKWOMWO table in the Database Expert and link as shown earlier in this document. 

11. Add a Group on Request Number. (GH2) 

12. Add another Group Header 2 section (GH2b). 

13. Create a Work Order subreport with the WKORDER and the WKWOMWO tables and place it in 

the Group Header 2b section (GH2b).  Link tables and subreport as shown earlier in this 

document (Work Order to Request). 
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14. In the subreport, drag the WO_Number field into the Detail section. Create one formula 

WOCount  

 WhilePrintingRecords; 

  Shared numberVar WOCount; 

  WOCount :=DistinctCount({WKORDER.WO_NUMBER}) 

15. Place the formula and the WO_NUMBER field as follows and suppress the subreport sections.  

This subreport is counting the Work Orders for each Request.  WOCount is a shared variable 

that is available to the main report. 

 

  

16. In the main report create a column header, Number of Work Orders. 

17. Create the next five variable formulas and place in the report as shown in the example.  
 

 

 

WOSum   (WOCount is being summed to calculate the Problem Total for Work Orders  

  and the Grand Total for Work Orders.) 

 WhilePrintingRecords; 

 Shared numberVar WOCount ; 

 Shared numberVar ProbWOCount ; 

 Shared NumberVar GrTotWOCount; 

 
 ProbWOCount:=ProbWOCount + WOCount; 

 GrTotWOCount:=GrTotWOCount + WOCount; 
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ProbTot 

 WhilePrintingRecords; 

 Shared numberVar ProbWOCount; 

 ProbWOCount 

 

TotalWO 

 WhilePrintingRecords; 

 Shared numberVar GrTotWOCount; 

 GrTotWOCount 

 

ZeroWO 

 WhilePrintingRecords; 

 Shared numberVar WOCount :=0; 

 

  ZeroProb 

 WhilePrintingRecords; 

   Shared numberVar ProbWOCount :=0; 

 

18. In Section Expert, make sure you select Suppress Blank Section for the GH2b section with the 

Work Order subreport. 

o Suppress sections as follows: 

 

 

Note: The GH2b section must not be suppressed in order to pass the subreport information 
to the main body of the report. Within the subreport all sections may be suppressed. 

 

 



Crystal Reports for Work Orders 38 

Preview 

 

                                                                                                                                                  Example 32A 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________

____________________________________________________________________________________ 
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Work Order Subtask Information to Assets 
The Work module now allows Subtasks to be assigned to specific Assets.  In order to show these 

relationships in a report, some fairly odd table links are required. 

 

 

This seemingly simple one line report took nine groupings and two subreports to get to the information. 

 

 

 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________ 
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Inventory Reports with Work Order Subtask 

Information 
In Lucity version 7.4 or newer, the availability of the WKTSKAST and WKWOTSK tables in the list of 

synonym tables allow the addition of subtasks when creating reports for the various inventory items. 

 

 

This too had some interesting table links: 

 

This report had five groupings and three subreports to assist the information out of the tables and into 

the report.  

If you are interested in creating a report with this subtask information, contact Lucity Support and we 

can help step you through the process. 

 


